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1. Using Reports 

Note: you are supposed to read the manual about Using Queries and the manual about Using Cubes before 
to read this one. 

1.1. Creating a new report from a Query 

You can create a report directly from the current open query by clicking the command Query> Create report 

or the icon , or you can create a report from the Click&DECiDE Project Report Tab by clicking the ñNewò 
icon: 
 

 

This command will ask you to choose among: 

 

Blank Report: creates an empty report inside of which you will insert manually the required static (Labels) or 
dynamic fields (if a query is later specified or using formulas) or other objects. This option is reserved to 
advanced users. 

Report from Query: this is the most used option that will create a report based on the query you will specify 
in the Data Source Item list box, using automatically all the query columns. 

Report Book: creates a report list of existing reports to be able to export or print them together as one global 
report. A Report Book can be printed to printer, exported to HTML or PDF formats. A Report Book cannot be 
exported to other Click&DECiDE Builder output formats. 

Report from Raw Cross Table Data: creates a report based on the cross-table you will specify in the Data 
Source Item list box by reading the cross-table rows as a data source. 

Warning: Report from Raw Cube Data: this option does not exist anymore in version 2015 because Builder 
64-bit cannot manage Microsoft Cubes, but a Report based on Raw Cube Data (as a data source) made with 
a 32-bit version of Builder (V13.x) can still be run through the Web Portal having Click&DECiDE 2015, but not 
in Builder 64-bit. 

Steps:  

1. Select the most used option Report from Query. (Other options are explained later) 

2. Click then on the Data Source Item list box to get the list of the available queries and select the one 
you need. Example selecting the demo_multicriteria from the Click and DECiDE Demonstration.wfv 
file. 

 

3. A default Report Template is proposed: 

You can select a standard template in the list and see a preview on the right pane. You can enlarge any 
preview by double clicking on the picture. Once you get the picture bigger, you also can switch to full screen if 
you want to see more details. 

Each template displays a comment about the Paper size, the Colour and Font, or information about the width 
and height size (fixed or modifiable). 
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4. Select the one you like and click OK. See also later how to create your own report templates using 
the command Tools> Report Templates command. 

5. Click OK to get automatically a new report with the following blocks or sections by default: Report 
Header, Page Header, Details, Page Footer, Report Footer. 

1.2. Saving a Report 

Once your report has been created and modified, you can save the report using the icon  or the command 
File> Save that will prompt you the Save asé dialog box proposing by default the query name on which the 
report is based. 

 

Modify the name if required and click OK. 

If you close the report, you can see in the Click&DECiDE Builder project report tab, the name of all the 
existing reports and, if the command View> Details from the Click&DECiDE Builder toolbar is activated, you 
also see some information such as Data Source (the name of the query on which the report is based), 
Description (empty by default) where you can add a comment about each report using the right mouse click 

and the Properties command or by clicking on the  icon: 

 

Also the date of creation and the date of last modification are displayed with the View> Details mode or in 
the Report Properties dialog box, as well as the Report Author that cannot be modified. 

You can sort the information in the Click&DECiDE Builder Project Report Tab by any column just by clicking 
on the heading column text. 

You also can change the position of each column from left to right or right to left moving a column to another 
location. To do that, click on a column and keep the mouse button pressed, then move the column to the right 
or to the left and drop the mouse button when the target location is reached. 
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1.3. Deleting a Report 

To remove a report, you must first open the Click&DECiDE Builder project file inside of which your report is 
located. Then select the Report Tab, select the report to be removed and use the <Del> key or press the 
<Remove> button. A warning message asks you to confirm. 

Be careful: that command could be dangerous because the lost report could be used by another report as a 
sub-report or be included in a Report Book. The Description box could be use to enter dependencies between 
several items. (Example a comment such as ñThis report is used as a sub-report in the report XXXXò). 

Make sure this report is not used anymore before confirming the warning message. There is no way to restore 
a report that you have deleted except if you made previously a backup of your project file (recommended). 

1.4. Reports Blocks 

A new report is made of the following blocks or sections by default: 

Report Header: printed one time at the beginning of the report 

Page Header: printed each time at the top of each page 

Details: printed on any page, containing the detailed records 

Page Footer: printed each time at the bottom of each page 

Report Footer: printed one time at the end of the report. That section is empty by default and you have to 
enlarge the size block if required. 

Other special sections can be created when using the Break levels functions. See later the Creating break 
levels. 

 

By default the Report Header is empty but you can enlarge this block to add a main title and logo for example. 

By default the Page Header contains the Column Header of your query and the Title is the query name. 

By default the Details contains the column fields of your query. 

By default the Page Footer contains the fieldôs saves in the Report Template such as printed date and time, 
Copyright and Page numbers. 

By default the Report Footer is not visible but you can enlarge this block to add some summary fields or totals. 
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1.4.1. General Block and Fields Properties 

You can apply to each block some properties according to the following table: 

Tab/Properties 
Report 
Header 

Page 
Header 

Detail Page Footer Report Footer 

General Tab      

Bookmark Yes Yes Yes Yes Yes 

Highlight Yes Yes Yes Yes Yes 

Format Tab      

Form Feed Yes  Yes  Yes 

New Row or Column   Yes   

Insecable Block Yes  Yes  Yes 

Visible Yes Yes Yes Yes Yes 

Width Yes Yes Yes Yes Yes 

Height Yes Yes Yes Yes Yes 

Can Grow Yes  Yes  Yes 

Can Shrink Yes  Yes  Yes 

Background Style Yes Yes Yes Yes Yes 

Background Color Yes Yes Yes Yes Yes 

Background Color 2   Yes   

Border Effect Yes Yes Yes Yes Yes 

Border Style Yes Yes Yes Yes Yes 

Border Color Yes Yes Yes Yes Yes 

Border Weight Yes Yes Yes Yes Yes 

Data Tab      

No property on a Block      

1.4.1.1. Form Feed Property: 

This property allows to specify if a section (block) must be printed on the current page or if a break page must 
be done before (or after or both) to print that section. 

Note: the Form Feed property doesn't apply to the Page Header or the Page Footer. 

Parameter Description 

No Default value. The current section (block) is printed on the current page 

Before Block The current section (block) is printed on a new page 

After Block 
The next section, coming immediately after the current section, will be 
printed on a new page 

Before & After Block 
The current section (block) is printed on a new page and the next section, 
coming immediately after the current section, will be printed also on a new 
page 

1.4.1.2. New Row or Column Property: 
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This property allows to specify if a section (block) content must be printed on a new row or new column in a 
multicolumn report. For example you can use that property to print each header group at the beginning of a 
new column in a multicolumn report. 

Parameter Description 

No 
Default value. Click&DECiDE Builder starts printing the section on the 
current page and finish printing on next page if the content doesn't feed on 
the same page, according to the Page Set-up parameters. 

Before Block 
Click&DECiDE Builder starts printing the current section (for example a 
Group Header) on a new row or column, then print the next section (for 
example a Detail) on the same row or column. 

After Block 
Click&DECiDE Builder starts printing the current section (for example a 
Group Header) on the current row or current column, then print the next 
section (for example a Detail) on a new row or a new column 

Before & After Block 
Click&DECiDE Builder starts printing the current section on a new row or 
column, then print the next section on a new row or a new column. 

Note: the New Row or Column property only applies to the Detail bloc. 

1.4.1.3. Insecable Block Property 

This property allows to specify if a section (block) content must be printed on the same page. 

Parameter Description 

No 
Click&DECiDE Builder starts printing the section on the current page and 
finish printing on next page if the content doesn't feed on the same page. 

Yes 
Click&DECiDE Builder starts printing the section on the next page if the 
section content doesn't feed on the current page. 

1.4.1.4. Visible Property 

This property allows to specify if a section (block) or an item (field) must be visible or hidden. It could be useful 
to keep access to information without displaying it in the result (in a formula for example). 

Parameter Description 

Yes Default value. The block or item is visible 

No The block or item will be hidden when editing or printing the report. 

 
Note: for the Page Header this Visible Property is particular: 

Parameter Description 

Always Default value. The Page Header block is always visible 

Never The Page Header block is never visible. 

Always except on 
widow Report Footer 
Page 

The Page Header block is always visible, except when the last Report 
Footer Page is widow. 

1.4.1.5. Height Property 

This property allows to specify the vertical size for a section (block) or an item (field). The unit is the one 
defined in the Windows Regional Settings (Inches, centimeters etc.) and two decimals are authorized after the 
decimal separator. Note: a vertical size set to zero is equivalent to the Visible option set to No. 

1.4.1.6. Width Property 

This property allows to specify the horizontal size for a section (block) or an item (field). The unit is the one 
defined in the Windows Regional Settings (Inches, centimeters etc.) and two decimals are authorized after the 
decimal separator. Note: all the Blocks have always the same width in a report. 
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1.4.1.7. Can Grow and Can Shrink Properties 

These properties allow to specify if a section (block) or an item (field) can grow or can shrink if the content, 
when editing or printing, is bigger or smaller than the current size defined. If that property is applied, the block 
size or the field size will be adjusted vertically automatically when you preview or print the report. 

Note 1: the Can Grow/Can Shrink properties do not apply to the Page Header nor the Page Footer. The result 
can be visible only when editing (preview) or printing the report. 

Note 2: if the Can Grow/Can Shrink properties are set to Yes for field items in a Block, this Block must also be 
defined with the same option set to Yes. 

Parameter Description 

Yes 
The block size or field size is adjusted vertically depending on the content 
to be printed or edited (preview) 

No 
Default value. The block size or field size will not change when printing or 
editing. Some data can be hidden if the size defined is too small. 

 

1.4.1.8. Background Style Property 

This property allows to specify if a section (block) or an item (field) must be transparent or opaque. 

Note: if transparent mode is selected, you cannot apply a Background color. As soon as you specify a 
background color, the Background Style is set to Opaque. 

Parameter Description 

Transparent 
Default value. The background is transparent and the color is the one of 
the block or the item the most on the background  

Opaque 
The block or field color will be the one defined with the property 
Background color. 

1.4.1.9. Background Color Property 

This property allows to specify the background color for a section (block) or an item (field). 

Note: when you specify a color for a block or an item, the Background Style is automatically set to Opaque 
instead of Transparent. 

The Background Color property uses as parameter a number corresponding to a specific color. 

 Use that button to display the available colors  

 Use that button to generate a customised color. 

 Use that button on the Report Format Toolbar to apply directly a color to the block or field background. 

1.4.1.10. Background Color 2 Property 

This property allows to specify a second background color for the Details block only that will give an alternate 
color to the rows in the report edition. 

Note: when you specify a color for a block, the Background Style is automatically set to Opaque instead of 
Transparent. 

The Background Color 2 property uses as parameter a number corresponding to a specific color. 

 Use that button to display the available colors  

 Use that button to generate a customised color. 

 Use that button on the Report Format Toolbar to apply directly the second color to the Details block. 

1.4.1.11. Border Effect Property 

This property allows to specify the border aspect for a section (block) or an item (field). 
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 Use that button to display the available border aspects in the combo-box list. 

 Use that button on the Report Format Toolbar to apply directly a border effect to the block or field: 

 2D -The object appears flat. 

 3D -The object has a highlight on the top and the left, and a shadow on bottom and right. 

 3D Down -The object has a shadow on the top and the left, and a highlight on bottom and 
right. 

 Grave -The object has a sunken line surrounding the control. 

 Shadow - The object has a shadow below and to the right of the control. 

 3D Underline - The object has a sunken line below the control. 

1.4.1.12. Border Style Property 

This property allows to specify the border style for a section (block) or an item (field). 

Use that button to display the available border styles in the combo-box list. 

 Use that button on the Report Format Toolbar to apply directly a border style to the block or field: 

 Default value. The border is not visible when editing or printing. 

 The border is visible as a solid line. 

 The border is visible as a dash line. 

 The border is visible as a point line. 

 The border is visible as a dash-point line. 

 The border is visible as a dash-point-point line. 

1.4.1.13. Border Color Property 

This property allows to specify the border color for a section (block) or an item (field). The Border Color 
property uses as parameter a number corresponding to a specific color. 

 Use that button to display the available colors  

 Use that button to generate a customised color. 

 Use that button on the Report Format Toolbar to apply directly a border color to the block or border field. 

1.4.1.14. Border Weight Property 

This property allows to specify the border weight for a section (block) or an item (field). 

 Use that button to display the available border weight in the combo-box list. 

 Use that button on the Report Format Toolbar to apply directly a weight to the block or field border. 

 Default value. The border weight is not visible when editing or printing. 

 The border weight is the smallest visible, as in the left example. 

 The border weight is greater, as in the left example. 
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 The border weight is greater, as in the left example. 

 The border weight is greater, as in the left example. 

 The border weight is greater, as in the left example. 

 The border weight is the greatest visible, as in the left example. 

1.4.1.15. Bookmark Property 

A bookmark can be displayed when exporting a report to a PDF format (Acrobat Reader). 

You can enter a text manually, as a bookmark displaying a fixed Title for the Report Header Block: 

 

But you also can use the  to generate a formula for the bookmark you need to display, example: 

 

Note that the formula automatically adds an equal sign at the first position. 

The above formula will generate a bookmark such as ñSales_Dashboard_2015_03ò if we are a day of March 
2015. 

Warning: if you enter a formula manually, without using the Formula Editor, you must enter manually the 
equal sign at the first position. 

1.4.1.16. Highlight Property 

A highlight is an attribute modification that can be done automatically according to a predefined condition. 

For a Report Block, a highlight can affect only 3 attributes: Visible Yes/No, and Background Style and Color: 

 

For a Report Dynamic Field, a highlight can affect much more attributes such as: 
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Note the Format attribute that allows you to customize a field data format if the condition is true, instead of 
using the default format. 

Note also the Hyperlink attribute that allows you to create here a link that can be displayed if the condition is 
true.  

Example 1: this link can call a bookmark in the same PDF Report file, in that case use the # sign followed by 
the Bookmark Name as in this example:  #Events by Hour of the Day 

Example 2: A Daily Report can call using this link another Monthly Report, with a formula similar to this 
example: ='Sales_Monthly_'+  FormatDateTime('yymm', Day_Selected ) +'.pdf'. 

Note that you can add several Highlights on the same object: for example the color of the amount can be 
different according to the value: the first condition will give a red number if true: 

 

 

The second condition will give an orange number if true: 
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The third condition will give a green number if true: 

 

 

And the last condition will give a blue number if true: 
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One of the conditions will be always true, so the result will get the corresponding color. 

For a Report Static Field, a highlight can affect the same attributes list as a Dynamic Field, but also a 
specific attibute named ñTextò allowing to modify a Label Title according to a condition. 
Example: in a report a Label Title display the word ñDateò by default, when the report is run on a Daily basis. 
But sometime the same report can be run on a Hourly basis, and in that case the information displayed in the 
same column will be hour instead of days. The following Highlight condition can modify the Label Title and 
display ñTimeò instead of ñDateò: 

 

 

 

For a Picture Field, a highlight can affect the following attributes including the picture to be used, such as a 
first condition displaying a red cross if the condition is true: 
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A second condition can display another picture if the condition is true: 

 

 

A third condition can display another picture if the condition is true: 
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And a last condition display another picture if the condition is true: 

 

The benefit of this method is to be able to display several different pictures using only one picture object. 

Test the result for year 2010 for example and see both effects: one on the color result in the Amount column, 
other one on the picture on the right of the result, in the details block: 
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Note: in the Highlight Dialog Box a toolbar displays the following icons: 

 New Condition 

 Edit Condition 

 Delete Condition 

 Move Up Item 

 Move Down Item 

 Reset the selected attribute to (Undefined) 

 Reset All attributes to (Undefined) 

 Cut 

 Copy 

 Paste 

1.4.2. Copying the custom colors 

Once you have defined in a report a customized palette of colors, you can use the command Edit> Copy 
Custom Colors and then use the command Edit> Paste in another report or another project file to restore the 
customized palette without the need to defined all colors again. 

 

1.4.3. Specific Field Properties 

Inside each Report Block, you can insert or copy several object types, such as Static Label field (static text), 
Data or Formula Field (Dynamic field) and other specific objects such as Query Data Object, Picture, Chart, 
Sub-Report, Cubes, Line, or ActiveX explained later. All these objects are proposed in the following Toolbar: 

 

 

You can apply to each Static Label or Data/Formula field additional properties according to the following table: 
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Tab/Properties 
Static 
Label 

Data / 
Formula 

Query 
Data 

Picture Graph 
Cross 
Table 

Sub-
Report 

Line 

General         

Name Yes Yes Yes Yes Yes Yes Yes Yes 

Description Yes Yes Yes Yes Yes Yes Yes Yes 

Hyperlink Yes Yes Yes Yes Yes    

Bookmark Yes Yes Yes Yes Yes Yes Yes Yes 

Highlight Yes Yes Yes Yes Yes Yes Yes Yes 

Format Tab         

Format  Yes Yes      

Visible Yes Yes Yes Yes Yes Yes Yes Yes 

Left Yes Yes Yes Yes Yes Yes Yes Yes 

Top Yes Yes Yes Yes Yes Yes Yes Yes 

Width Yes Yes Yes Yes Yes Yes Yes Yes 

Height Yes Yes Yes Yes Yes Yes Yes Yes 

Hide Duplicates  Yes       

Can Grow  Yes Yes   Yes Yes  

Can Shrink  Yes Yes   Yes Yes  

Image    Yes     

Image Type    Yes     

Draw Mode    Yes     

Horizontal Alignment    Yes     

Vertical Alignment    Yes     

Background Style Yes Yes Yes Yes  Yes Yes  

Background Color Yes Yes Yes Yes Yes Yes Yes  

Border Effect Yes Yes Yes Yes Yes Yes Yes Yes 

Border Style Yes Yes Yes Yes Yes Yes Yes Yes 

Border Color Yes Yes Yes Yes Yes Yes Yes Yes 

Border Weight Yes Yes Yes Yes Yes Yes Yes Yes 

Text Yes        

Text Color Yes Yes Yes      

Font Yes Yes Yes      

Bold Yes Yes Yes      

Italic Yes Yes Yes      

Underline Yes Yes Yes      

Strikeout Yes Yes Yes      

Text alignment Yes Yes Yes      

Display       Yes  

Data Tab         
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Tab/Properties 
Static 
Label 

Data / 
Formula 

Query 
Data 

Picture Graph 
Cross 
Table 

Sub-
Report 

Line 

Data Source  Yes Yes  Yes Yes Yes  

Aggregate  Yes       

Child Data Link   Yes   Yes Yes  

Parent Data Link   Yes   Yes Yes  

Update Method   Yes    Yes  

Assign to Parameter  Yes Yes      

Series     Yes    

Data     Yes    

First Records     Yes    

Other Series 
Records 

  
  

Yes    

Series in rows     Yes    

Reverse Data Order     Yes    

Refresh Data      Yes   

Apply defined levels      Yes   

 

In the above Table, some Properties are already explained in the previous paragraph. The other Properties 
are described here: 

1.4.3.1. Name Property 

This property allows to specify an internal name for an item (label field or data field) that can be used later in a 
formula for example. Each object must have a distinct name. The name cannot be the same as a data source 
field name. The name cannot contain space neither special characters. 

Note: Click&DECiDE Builder attributes automatically a new internal name by default when inserting a new 
label field or a new data field or any other object. If the name already exists, a number is added to this name. 

1.4.3.2. Data Source Property 

This property allows to specify how to feed a dynamic object. A query column name or a formula for a 
Data/Formula object, a query name for Query Data object, <Report Data> or a query name for a Graph, a 
report name for a Sub-Report, a cross-table name or a Cross Table. 

1.4.3.3. Aggregate Property 

This property only applies to Data / Formula object, and allows to generate a grouping function in the report, 
such as Sum, Min, Max, Average, Count, Standard Deviation and Variance. 

1.4.3.4. Child and Parent Data Link Property 

This property only applies to Query Data, Sub-Report and Cross-table objects, and allows add a criteria 
between a column of the report data source and the object data source. This property will be described more 
in detail later for the concerned objects, and is mainly used when creating Break Levels in a report. 

1.4.3.5. Assign to parameter Property 

This property allows to assign the field content to a parameter that can be used later in the same report inside 
a formula, or in a sub-report, or in another report belonging the same Report Book if the query of this report is 
also referenced with the same parameter. 
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1.4.3.6. Text Property 

This property allows to specify the visible text for a Static label field such as a Title, a Sub-Title, a Column 
name, a Comment etc. 

Note : Click&DECiDE Builder attributes automatically the default text "Text" to any new label field inserted 
inside a block report. You can use the Format Tab in the Properties Dialog Box to see or modify it. 

If the text you want to type is quite long, you can use the Text Editor by clicking on the  right browse 
button. Example: the following text in the Text Editor 

 

Will give this result in the Report: 

 

1.4.3.7. Format property 

This property allows to specify the format to be used to display the data field content when editing or printing 
the report. 

Note: Click&DECiDE Builder proposes automatically several Windows default standard formats depending on 
the field type (text, numeric, date, time or timestamp) and your Regional Settings. You can modify them. 

 Use that button to display the available formats depending on the field type 

Parameter Description 

0,00 
Example for numeric value without thousand separator and semicolon as 
decimal separator 

#.##0,00 
Example for numeric value with a dot as thousand separator and 
semicolon as decimal separator 

#.### £ Currency with the English pound without decimals 

#.##0,00;-#.##0,00;<Null> 
Example for numeric value with a dot as thousand separator, a semicolon 
as decimal separator, a minus sign for negative values and a Null 
information for null content. 

# ##0,00 ú;-# ##0,00 ú;<Null> 
Example for numeric value with a space as thousand separator , a 
semicolon as decimal separator, a ú for Euro money, a minus sign for 
negative values and a Null information for null content. 

0% 
Example for numeric value with a percentage presentation, without 
decimal 

dd/mm/yyyy 
Example for a date value, with 2 numbers for the day, 2 numbers for the 
month and 4 numbers for the year. 
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Parameter Description 

dd/mmm/yyyy 
Example for a date value, with 2 numbers for the day, 3 first character for 
the month and 4 numbers for the year. 

hh:mm:ss 
Example for a time value, with 2 numbers for the hour, 2 numbers for the 
minutes and 2 numbers for the seconds. 

dd/mm/yy hh:mm 
Example for a timestamp value, with 2 numbers for the day, 2 numbers for 
the month, 2 numbers for the year, 2 numbers for the hour, 2 numbers for 
the minutes and no seconds. 

1.4.3.8. Left Property 

This property allows to specify the object position from the Left border of the Report. The unit is the one 
defined in the Windows Regional Settings (Inches, centimeters etc.) and two decimals are authorized after the 
decimal separator. 

1.4.3.9. Top Property 

This property allows to specify the object position from the Top border of the current report Block. The unit 
is the one defined in the Windows Regional Settings (Inches, centimeters etc.) and two decimals are 
authorized after the decimal separator. 

1.4.3.10. Hide duplicates property 

This property allows to specify if an item (dynamic field) must be duplicated or not on each row on the same 
page when the content doesnôt change. This option only concerns the Detail Block (section) in a report. It 
could be useful to not display the same information on each row when the content of a field is equal to the 
content of the previous record. 

1.4.3.11. Image Property 

This property only applies to an Image object and allows to specify the full path and file name for the required 
picture. Example: C:\Users\Public\Documents\Click and DECiDE Samples\Builder\mountain.JPG 

Note 1: this path can contain some parameters as you can see in the report example ñSales by Categoryò in 
the Click and DECiDE Demonstration.wfv project file. In that example note that the Image Type must be set 
to Formula. 

='%CND_BAI_SAMPLES%\ Builder \ '  +  "CATEGORY_NAME"  + '.JPG'  

Note 2: the picture file name can be defined using the Highlight Property in the General Tab as describe in the 
Highlight paragraph. In that case, no picture files name need to be defined in the Image Property. 

1.4.3.12. Image Type Property 

This property only applies to an Image object and allows to define if the picture is: 

Included in the report: in that case you donôt need to give the picture with the project file to somebody else, 
but the project size could be affected by many big pictures. 

Linked to the report: in that case you need to give the picture separately with the project file to somebody 
else, but the project size is not affected by the number of pictures. 
 

Example: 
C: \ Program Files \ Click and DECiDE \ BAI \ Templates \ Images \ cndlogo_45_45.png  

Formula: must be used if you specify a formula in the Image Property box as the above example with the 
variable environment and the parameter name. 

1.4.3.13. Draw Mode Property 

This property only applies to a Image object and allows to modify the picture presentation among 4 choices: 
Normal, Stretched, Homothetic and Mosaic. 
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Draw 
Mode 

 
Description 

Normal 

 

Default value. The picture will be displayed with the original size 
without the need recalculate the size when editing or printing the 
report, saving resources for the program. 

Stretched 

 

The picture will be displayed extended or reduced to fit the size 
object. Distortion can thus occur if needed. 

Homothetic 

 

The picture will be displayed to fit the size object without distortion. 

Mosaic 

 

The picture will be displayed to fit the size object in a mosaic mode 

1.4.3.14. Horizontal Alignment 

This property only applies to an Image object and allows to define the horizontal position in the object.  

Horizontal 
Alignment 

 
Description 

Left 

 

The picture will be displayed on the left side of the object. 

Center 

 

Default value. The picture will be displayed in the center of the 
object (horizontally). 

Right 

 

The picture will be displayed on the right side of the object. 

1.4.3.15. Vertical Alignment 

This property only applies to an Image object and allows to define the vertical position in the object.  

Vertical 
Alignment 

 
Description 

Top 

 

Default value. The picture will be displayed on the top side of the 
object. 

Center 

 

The picture will be displayed in the center of the object (vertically). 

Bottom 

 

The picture will be displayed on the bottom side of the object. 
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1.4.3.16. Series Property 

This property only applies to a Graph object. You can specify here which column has to be used as series for 
the graph. It could be one or several columns. The column could be a query column or a report dynamic field. 

Use the  icon to display this column list or the  icon to select several query or report columns. 

1.4.3.17. Data Properties 

This property only applies to a Graph object. You can specify here which column has to be used as data for 
the graph. It could be one or several columns. The column could be a query column or a report dynamic field. 

Use the  icon to display this column list or the  icon to select several query or report columns. 

1.4.3.18. First Records Property 

This property only applies to a Graph object. You can add a Top value specific to the Graph if you wish to limit 
the data displayed by a Graph without limiting the report data. It is useful for example for a Pie Chart because 
when you have more than 20 or 25 sectors, the Pie Graph can be not very readable. 

1.4.3.19. Other Series Properties 

This property only applies to a Graph object. This option allows you to specify a Legend Text to all other 
series that will be displayed as one additional series if the Top Value specified in the First Records Property is 
reached. 

1.4.3.20. Series in Rows 

This property only applies to a Graph object. The default value for a new Graph is Series in Columns. You can 
switch her for the option ñSeries in rowsò if needed. It is useful for example sometimes with a Pie Chart. 

1.4.3.21. Reverse Data Order 

This property only applies to a Graph object. You can change the order of the displayed data (Left/Right or 
Top/Bottom). 

1.4.3.22. Text Color Property 

This property allows to specify the text color for an item (Label field or Data field). The Text Color property 
uses as parameter a number corresponding to a specific color. 

 Use that button to display the available colors. 

 Use that button to generate a customised color. 

 Use that button on the Report Format Toolbar to apply directly a color to the label or data field text. 

1.4.3.23. Font Property 

This property allows to specify the font for an item (Label field or Data field). 

The Font property uses as parameter a font name chosen in the list proposed by your Window configuration. 

 Use that button to display the available font parameters on your machine (the dialog box provided allows 
you to select a font, a style (bold, italic, etc.), a size, a color, a special effect such as underlined etc.. 

1.4.3.24. Bold Property 

This property allows to apply a bold effect to a item content (Label field, Data field or Query Data field). 

1.4.3.25. Italic Property 

This property allows to apply a Italic effect to a item content (Label field, Data field or Query Data field). 

1.4.3.26. Underline Property 

This property allows to apply an Underline effect to a item content (Label field, Data field or Query Data field). 

1.4.3.27. Strikeout Property 

This property allows to apply an Strikeout effect to a item content (Label field, Data field or Query Data field). 

1.4.3.28. Text Alignment Property 
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This property allows to specify the Alignment required for a label or data field text. 

 Use that button to display the available alignment effects in the combo-box list or use directly the following 
toolbar buttons: 

 Use that button on the Report Format Toolbar to align directly the text on the Left border of the field. 

 Use that button on the Report Format Toolbar to align directly the text on the Center of the field. 

 Use that button on the Report Format Toolbar to align directly the text on the Right border of the field. 

1.4.3.29. Description Property 

This optional property allows to specify a description for an item that can be displayed later when editing a 
formula for example. The current description will appear in the Description box when using the Quick 
Expression formula generator. This description will also be used when exporting a report to Excel, allowing to 
align all objects having the same description in the same column. 

This is useful when you create a formula that will be used later from within another formula. The description 
will help you to remember what the purpose of each formula is. 

Example: a virtual field named TOTAL_PRICE will receive the formula (price * qty) * (1-discount) and the 
description "Price after discount". Now a new formula can be created to apply the local tax. When editing the 
formula from within the Quick Expression generator, the field TOTAL_PRICE will display the description "Price 
after discount" in the Description box: 

1.4.3.30. Hyperlink Property 

This property allows to enter an URL or Hyperlink calling for example: 

a Web site: ='http://www.clickndecide.com' 

a Bookmark in the same PDF report: #HomePage or ó#ô+ Username (if Username is a dynamic query field 
used in the report) 

a Bookmark in another PDF report using a formula: ='Statistics_Monthly_'+  FormatDateTime('yymm', 
Day_Selected ) +'.pdf', Day_Selected being a parameter name. 

an URL calling a PDF or HTML report including one or several parameters: 
='/dvweb/display.aspx?__mnu_alias=Demonstration&__mnu_itemid=2357&__format=HTML&AREA_PARAM
='+AREA+ô&__exec=1ô. 

1.4.3.1. Refresh Data 

This property only applies to a Cross table object and allows you to specify if the Cross table must be 
recalculated at the runtime report. If not the data saved in the cross-table data file (*.vpd) will be used. 

1.4.3.2. Apply defined levels 

This property only applies to a Cross table object and allows you to specify: Yes, the levels defined with 
condensed or detailed mode will be applied as they have been saved, or No, do not apply the defined levels 
and make them all detailed. 

1.4.3.3. Display Property 

This property only applies to a Sub-Report object. This function proposes by default to retrieve from a sub-
report only the Detail and Break Blocks. But you can ask to retrieve All Blocks from a sub-report if you also 
need to retrieve the title, the column headers and the total fields (in the Report Footer Block) from the sub-
report. 

1.4.3.4. Update Method 

This property only applies to a Sub-Report or Query/Data object: Optimized means that the SQL calculated to 
run a sub-report or query/data is done only one time, as parameter values are known and Child Data Link and 
Parent Data Link are known. Forced means that this SQL will be recalculated each time. This can be used 
when a parameter value can change because of the use of the ñAssign to parameterò feature. 
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1.5. Report Properties 

If you click the  icon, you will get the Report Properties, with 3 specific properties applying to the whole 
report: 

Report Property Description 

Run Condition 
The value of a parameter can be evaluated here to check if a 
condition is true of false. If false the report will not be printed, avoiding 
an empty page inside a Report Book. 

Single Page HTML export 
This option allows to specify that the current report must be exported 
using only 1 page if the output format is HTML. 

Web Part Entry Chart 

This option allows to specify the graph to be used as an entry point 
into a Web Part created in the Web Portal. The URL, with HTML 
output, copied from this report will only display the selected Graph in 
the Web Part, but the URL proposed in the Title will drill-down to the 
full report. (Refer to the Click&DECiDE Web Portal User Guide 
Manual to know more about Web Parts). 

 

1.6. Report Toolbars and Look 

You can modify the report look by using the commands: 

1.6.1. View> Ruler 

This command will show or hide the vertical and horizontal rulers: 

 

1.6.2. View> Grid 

This command will show or hide the grid: 

 

1.6.3. View> Header and Footer Blocks 

Use the command View> Report Header/Footer to display or remove with one click the Report Header Block 
and the Report Footer Block. Warning: when you remove these blocks, a message prevents you that you will 
lose their content. 
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Use the command View> Page Header/Footer to display or remove with one click the Page Header Block 
and the Page Footer Block. Warning: when you remove these blocks, a message prevents you that you will 
lose their content. 

1.6.4. View Toolbar 

This command allows to display several Toolbars. 

1.6.4.1. Toolbar 

 

See the legend to know what icon is doing. 

1.6.4.2. Toolbox 

 

See the legend to know which kind of object each icon will add in your report. 

1.6.4.3. Layout Bar 

 

Use this toolbar to modify the objects and fields layout. 

1.6.4.4. Alignment/Resize Bar 

 

See the legend to know what icon is doing. 

1.6.4.5. Spacing Bar 

 

See the legend to know what icon is doing. 

1.7. Reports Objects and Fields 

Once a report has been created, with the default blocks containing the default objects and fields according to 
the query structure, you can wish to: 

1.7.1. Add a new query field 

If you need to add some fields in a report already based on an existing query, do the following steps: 

1. Click the Report Property icon  then select the Data Tab where you will see the query name used a 

data source. Click the  icon to open the query. Select the new required field(s) in the query and 
save the query. 

2. Close the query and go back to the report based on that query. 

3. Click now the Query Field list icon  or on the command View> Field list and you will get a window 
containing all the query fields: 
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4. Select one or several field(s) in the above list (using the Shift+click or Ctrl+Click) and make a drag 
and drop to the required location in your report, in the concerned block. Drop the mouse button when 
the target location is correct. The new field(s) is (are) inserted on the target location. 

5. Note that you have to create and add yourself the heading text if required in the Page Header Block 
for the new inserted fields. 

1.7.2. Add a new report field or object 

If you need to add other reports objects, use the command View> Tools Bar> Toolbox 

 

1.7.2.1. Static Text (Label) 

1. Click  to add a new static text. 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. 

4. Enter now the Text in the Text box in the Properties Format Tab. 

1.7.2.2. Dynamic field (Data/Formula) 

1. Click  to add a new dynamic field that could be fed by a query field or a report formula. 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. 

4. Select the Properties Data Tab and click the  icon in the Data Source box to select a query field or 

click the  icon to open the Quick Expression Editor to enter a formula. 

1.7.2.3. Query Data 

1. Click  to add a special Query Data object 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. This object must be fed by a query but will display only the result of the first 
row and the first column of this query. 

4. Select the Properties Data Tab and click the  icon in the Data Source box to select a query 

name or click the  icon to create the appropriate query if needed. 

1.7.2.4. Picture 

1. Click  to add a picture 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. A dialog box immediately opens to search for the picture file name. 

4. Select the image file and click Open. 

5. Select then the Properties Format Tab to specify the Image Type, Draw Mode, Horizontal and 
Vertical Alignments. 

1.7.2.5. Graph 

1. Click  to add a dynamic chart 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. A dialog box immediately opens to offer a choice of chart templates. 

4. Select the one you need and click OK. 

5. Select the Properties Data Tab where the Data Source box is defined by default with <Report 
Data>. 
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6. Specify then the Series and Data boxes using the  icon to select a report field, or the  icon 
to open a dialog box allowing to select several report fields. Note that <Report Data> will build the 
Graph using the report data, avoiding to run a separate query. Nevertheless a Graph can also be 
fed directly by a query. If a query name has been used and you want to display again <Report 
Data>, display the query list and select the <Report Data> in first position or delete the query 
name with the Del key and press Enter. 

7. Optional: define a Top value in the First Records box if you want to limit the number of values for 
the Graph, the extra data will be display as one value whose legend can be defined in the Other 
Records Series. 

8. Optional: right click on the Graph and select the Edit command to open the Click and DECiDE 
Chart Designer. 

9. Once you have modified the Graph using the Chart Designer you can save your own template 
using the command File> Save As and give a customized file name to the template 
(MyGraph.cfx), located by default in the C:\Program Files\Click and DECiDE\BAI\ChartModels 
directory. 

1.7.2.6. Cross-Table 

1. Click  to add a dynamic cross-table. 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. 

4. Select the Properties Data Tab and click the  icon in the Data Source box to select a cross-

table name or click the  icon to open the specified cross-table. 

5. If needed, specify the Child and Parent Data Links. 

6. Change, if needed, the option Refresh Data defined to Yes by default. 

7. Change, if needed, the option Apply Defined Levels defined to Yes by default. 

1.7.2.7. Sub-Report 

1. Click  to add a dynamic sub-report. 

2. Define the target location in the required block by drawing a frame with the dimension you need. 

3. Release the mouse. 

4. Select the Properties Data Tab and click the  icon in the Data Source box to select a report 

name or click the  icon to open the specified report. 

5. If needed, specify the Child and Parent Data Links. 

1.7.2.8. Line 

1. Click  to add a static line. 

2. Define the target location in the required block by drawing a line with the dimension you need. 

3. Release the mouse. 

4. Specify the Border Weight as well as the other attributes. 

1.7.2.9. ActiveX Control 

1. Click  to add an ActiveX control. 

2. Select the required ActiveX in the proposed list. 

3. Define the target location in the required block by drawing a frame with the dimension you need. 

4. Release the mouse. In the Properties Data Tab, the OLE Class and Class boxes are 
automatically fed. 
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5. Only specify the query field in the Data Source box. Note that the General Tab is depending on 
the ActiveX object and contains many parameters reserved to advanced users. 

1.8. Creating Break Levels 

Click&DECiDE Builder allows to create several break levels in a Report. Each break level will allow to display 
a Group Header Block before the Detail Block and a Group Footer Block after the Detail Block. Each of 
these groups can display Static or Dynamic Title, and also calculated fields to display totals, averages, 
minimum, maximum etc. Data can be sorted inside the report through each break level. 

To explain the Break Structure, the best is to create a report as an exercise and to build, step by step, several 
break levels. 

To do so, we are going to make an example starting with a query joining the tables SALES and SALESMAN 
from the Secured SQL Server Database. You can use the demo_multicriteria query from the Click and 
DECiDE Web Demonstration.wfv project file or create the same query. (Refer to the Click&DECiDE Query 
User Guide.pdf manual if needed). 

1. Open the query demo_multicriteria (or make a copy), it should look like: 

 

2. Create a Report using a Template: 

 

3. Save this report as Report Training for example. 

4. Now, click on the command View> Field group or on the  icon to get the following dialog box:  
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5. In the above screen, click the arrow on the right of the Field Group box to get the query column list 
and select for example the AREA field to create a break level for each Area: 

 

6. Select Yes for both Group Header and Group Footer and select ñWith First Detailò in the last 
option. 

Group Header: That group will be display before the rows concerning the break level. Generally used 
to inform what will be the next break information 

Group Footer: That group will be display after the rows concerning the break level. Generally used to 
generate calculation fields like Sum, Min, Max, Average etc. concerning the rows of the previous 
break level. 

7. Sort Order: by default Ascending is proposed. You can switch to Descending or None. Warning: the 
None option can be used only if you are sure to get the data sorted in the query in a right way for the 
break levels. 

8. Group on: make a choice among: 

 

¶ Value and First Characters for a Text field. if Value is selected, the break level will be done on 
the entire value content, if First Char is selected, you can specify how many characters must be 
used to produce a break level. (For example the 2 first characters of a postal code in France will 
produce a break level on the Department area) 
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¶ Value and Year/Quarter/Mont/Week/Day of month/Day/Hour/Minute/Second for a Date field. if 
Value is selected, the break level will be done on the entire value content, if a Date Time 
dimension is selected, you can specify the periodicity to be used to produce a break level. (Each 
year, each month etc.). Day of the Month will produce a break by day (but taking care about the 
date), whereas Day will produce a break by day without taking care about the date, unless this 
break is created after a Month Break. 

 

 

¶ Value and Interval for a Numeric field: if Value is selected, the break level will be done on the 
entire value content. If Interval is selected you can specify the interval range. 

9. Keep Together: you can select an option among No, Entire group or With first detail. 

¶ If No is selected, a new page can be created regardless the state of the current break level 

¶ if Entire group is selected a page break will be done if the new Break level cannot be displayed 
or printed on the current page 

¶ if With first detail is selected, the new Break level will start on the current page only if several 
first detailed row can be displayed on the current page, if not a page break will be done. 

We have defined in the previous example a first break level on the AREA field. The report should appear like 
the following example: 

 

By default the Group Header AREA contains the field used in this break level, to display the name of the next 
area coming in the report edition, and by default the Group Footer AREA also contains the field used in this 
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break level to display the name of the just listed Area, but also contain the sum of any numeric field, to display 
the sum of the TOTAL field after each Area (first break level). In this example we will delete the field 
SUM(SAL) because we do not need a total on the Salesman code, but we will keep the Sum(TOTAL). 

You can edit the properties of the AREA field in the Group Header Area block and modify in the Data Source 
box in the Data Tab the AREA field into a formula such as 'Salesmen for the area ' + AREA that will appear 
with the equal sign in the Data Source box ='Salesmen for the area '+AREA. 

Warning: be sure to enlarge enough the width of this field to not truncate the result. 

You can also select a background color for the Group Header AREA and the same color for the Group Footer 
AREA. 

You can edit the properties of the AREA field in the Group Footer Area block and modify in the Data Source 
box in the Data Tab the AREA field into a formula such as 'Sub-total for the area ' + AREA that will appear 
with the equal sign in the Data Source box ='Sub-total for the area '+AREA. 

Warning: be sure to enlarge enough the width of this field to not truncate the result. 

You can modify the format of the Sum(TOTAL) field in the Group Footer AREA to customize the numeric 
format if needed (currency, decimal etc.) 

The Report should like as the next picture: 

 

If you run that Report, for the chosen year or period, you will get a detailed list of all the sales done by all the 
salesmen for each different area. All the areas are in ascending order. Each Group Header AREA will display 
the title "Salesmen for the area " followed by the area name, and after the Detail Block, the Group Footer 
AREA will display the text "Sub-total for the area" followed by the area name and the sub-total representing 
the sum of the TOTAL field for all the salesmen and dates in the list, as in the following example: 
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Note that a page break could be done between each area break if we modify the option "Keep together" from 
ñWith First Detailò to "Entire group" in the Field Group dialog box. Save the report Report Training. 

1.8.1. Adding a main total at the end of the Report 

If you also wish to get a main total at the end of the report, go back to the Report and increase the size of the 
Report Footer Block by selecting the black line under the block title "Report Footer" and copy again the field 
Sum(TOTAL) from the Group Footer AREA. You also can add a label text to display a title such as "Main 

total" using the  icon from the Toolbox. The bottom Report should appear like the following picture: 

 

And if you run again the report you will get the main total on last page, after the last Area break: 

 

Remark: it could be sometimes necessary to increase the size of the Total field in a Break Group or in the 
Report Footer Group because the total of all data could give a bigger result that could not feed in the Total 
field size coming from the Details Block. (the Data could be truncated unless you apply the Can Grow 
Property, or could be visible but not aligned with the same Total field from other blocks). 

1.8.2. Hide the detail block and get only the Break level result 

If you only wish to get the Break Level result and hide the Detail Block, click on the Details block and go to the 
properties dialog box: select No in the Visible box. 

mailto:support@clickndecide.com
http://www.clickndecide.com/


 

37 
 

 

 

Business Application Intelligence | Training 

www.clickndecide.com Contact us: E-mail: support@clickndecide.com Tel: +33 (0)4 67 84 48 00 
Headquarters: Click&DECiDE 130, rue du Baptistou - 34980 St Gély du Fesc, France. 
To contact your nearest Click&DECiDE partner, click here. 

 

Do the same for the Group Header AREA to hide that block, to avoid to get twice the information about the 
Area in the Group Header and Group Footer. In the Page Header Block, you can also hide the heading Code, 
Salesman Name and Date to not display this text in the condensed mode because no salesman neither date 
will be display. Run the Report to screen. The result should be something like the next picture if you have 
formatted all the numeric fields for a currency for example: 

 

1.8.3. Adding a second break level 

Go back to the previous situation, with the Group Header AREA and the Detail blocks visible, and also the 
heading Code, Salesman Name and Date visible in the Page Header block. To add another break level, inside 

of each area, go back to the Field Group dialog box using the  icon: 

 

In the previous example, we will add a second break level on the SALESMAN name: 
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In the above Break level 2 for the salesman name, the Group Header is not required but the Group Footer is 
required to display the sum of the TOTAL field when the break will occur for each salesman. The option Keep 
Together is set to "With first detail", so a page break will be done only if no detail can be inserted before the 
page bottom. You can now modify the report to give another color to the Group Footer SALNAME and modify 
the SALNAME field with a formula such as =ôSub-total for the salesman ó+SALNAME. The Report should 
appear like the next picture: 

 

If you run that report, the beginning will be the same as before, with the title for the Break level 1 for each area 
(in green in our example), then the detailed list of the sales for the first salesman. 

Then, after the first salesman and before the next salesman (in the same area), the report will produce a 
break level 2 for the total of the current salesman (in yellow in our example). 

If more salesmen exist for the same area, we get the detailed list for the next salesman and then the report 
will display another break level 2 for the total of the next salesman (in yellow in our example) and will display 
after that a break level 1 to give the sum of total for the area (in green in our example), because the next 
record will concern another area: 
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Important note: in the above example, the Group Header Area is only display the first time when starting a 
new area level. But that information is not repeated on next page until the area change. 

You can force that option to repeat the Group Header Area on each page by selecting Yes in the Section 
Repeat box in the Group Header Area properties (Format Tab). 

 

You can now again ask for no detail, hiding the Details Block and get a condensed result for the 2 break levels 
thus defined and the main total: 
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You can add other breaks levels using the same way as describe in this chapter.  

1.8.4. Sending a report with break to Excel 

When sending a report to Excel, Click&DECiDE Builder only sends the Details and Break blocks fields. The 
other report blocks such as Report Header, Page Header, Page Footer and Report Footer are ignored. 

In order to define a column header inside the target Excel Sheet, Click&DECiDE Builder uses the Description 
box content from each Details Block field. If the Description is empty, then the program uses the internal 
object Name, that cannot contain spaces neither special characters and cannot be used twice with the same 
name in a report. We strongly recommend thus to use the Description box to define such headers. 

The problem when sending a report to Excel is that all data fields from the Details Block and the various Break 
Header or Break Footer Blocks are not always aligned vertically. The solution provided by Click&DECiDE 
Builder is given if you take care about the following rule: 

ñEach data field sent to Excel and having the same Description content will be sent in the same Excel 
sheet columnò. 

In our report example with the 2 break levels, on Area and Salesman, we will enter in the Description box the 
word Area for all columns that should be in the same Excel sheet column: 

 

Then we will apply the same rule for the Salesman Name column. 
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